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Bits and Pieces 
 
There are some bits and pieces of Elements that I thought might be useful to 
you but which didn’t really fit in elsewhere or would have made the relevant 
tutorial too long. So, I’ve grouped some of them here. 
 
The first thing I want to show you is how to use layer masks. This is a huge 
subject so we can only cover the basics here, but I hope there’s enough to 
encourage you to investigate further on your own. 
 

Layer masks 
Many thanks to Lesley Houghton for letting me use her lovely pictures. 
 
We’ve already used built in layer masks to restrict the area of an image 
affected by an Adjustment Layer in the Layers 2 tutorial. Here we’re going to 
look at masks that you can apply to any layer of your image. These mask or 
hide areas of the layer. 
 
Why would we want to do this when we can use various selection methods to 
cut out areas of an image, such as cutting the lily out of its background? Well, 
this is a destructive method so, if you change your mind about, for instance, 
how much of the image to use at a later date then you would have to re-do 
quite a bit of work to get the result you want. Using a layer mask gives you a 
non-destructive way to do the same thing that you can go back to and edit at 
any time. 
 
Basic commands for Layer Masks 
Note that you can’t add a layer mask to a locked background layer – you have 
to unlock it first. 
 
There are three ways to create a layer mask.  
 

The default is to create an empty 
layer mask on the active layer – ie 
you start with all the image showing. 

Click on the Create Layer Mask icon 
on the Layers panel – looks like a 
little camera with the lens pointing 
towards to you. 

To create a full layer mask on the 
active layer ie you start with all the 
image obscured. 

Alt-click on the Create Layer Mask 
icon on the Layers panel. 
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If you have an active selection then 
you can create a mask based on the 
selection.  

Clicking on the Create Layer Mask 
icon on the Layers panel gives a 
mask with all the non-selected area of 
the image masked out. 

 

To temporarily hide the mask Right-click the layer and select 
Disable Layer Mask from the drop 
down list. 
Tol switch it back on, select Enable 
layer mask from the same place. 

To delete a Layer Mask without 
deleting the layer itself. 

Right-click on the Layer Mask 
thumbnail NOT the layer thumbnail, 
and select Delete Layer Mask. 

 
 
Notes: 

➢ You can use any of the selection tools to make your selection before 
you create your layer mask. 

➢ It sounds obvious but if you want to paint on the mask, make sure the 
mask is active – you can see that it has a border round it when it’s 
active. If the layer is active you will paint on the layer, not the mask. 

➢ The keyboard shortcut to swap the foreground and background colours 
is x. So if you are painting on a layer mask you can swap easily from 
black to white just by pressing the x key.  

➢ You can go back at any time to add more black (to conceal areas of the 
layer) or white (to reveal areas of the layer). 

 
A couple of things to consider: 

➢ There are two ways to view your mask in the working area: 
o You can alt-click on the mask thumbnail which will show you a 

black and white version of the mask. 
o You can alt-shift-click (or \) on the mask thumbnail to see a red 

translucent overlay. NB if your mask is completely filled with 
white using this keyboard combination won’t do anything. 

➢ We’ve only used black and white on our layer mask so far as it shows 
the workings most clearly but you can use any shade of grey as well to 
give, if you like, selective opacity – the darker the grey,  the less you’ll 
see of that area. 

 
There are also text tools that create masks. These are under the regular text 
tools in the toolbox. You may have selected one of these by mistake at some 
point and wondered why your  image turned red all of a sudden.  It’s because 
you’ve selected a text mask tool instead of a text tool. 
 
A text mask tool creates a selection of an image based on the text you 
choose. To do this you select the text mask tool and click on the image, which 
then turns red – don’t panic! This indicates a mask in the same way as it does 
on a layer mask. When you start typing you aren’t really creating text you’re 
creating text shaped selections. To complete the cutout, inverse the selection 
and delete the area around the text shape. You’ll recognise the result as we 



Stone Creek Textiles, Stone Creek House, Sunk Island, E Yorkshire. HU12 0AP 
Telephone No: 01964 630630  E-mail:  ruth@stonecreektextiles.co.uk   

Web site: www.stonecreektextiles.co.uk 

achieved the same thing in Layers 2 using a clipping mask. This way to do it 
is probably quicker but it’s less flexible as once you’ve committed the text 
shapes (clicking on the green tick) you can’t then change or reposition the 
text. With a clipping mask you can change or move the text at any point. 
 

Layer styles 
Layer styles give you the ability to add things like a drop shadow or a bevel 
effect to the contents of a layer. The oddity to my mind is that you can’t apply 
a layer style from the Layers panel – you either have to go to the Layer menu 
or you need to bring out the Effects panel. 
 
In the Layer menu – Layer  > Layer Style > Style settings– you’ll find  four built 
-in layer styles – drop shadow, glow, bevel and stroke, with options to change 
some of their settings. Once you’ve applied a style, you’ll see a faint fx symbol 
on the right hand side of the layer in the Layers panel. If you want to edit the 
settings for the style, you double click the fx symbol and it will bring up the 
styles dialogue box and you can make your changes. 
 
In the Effects panel, from the Window menu, you’ll find whole rafts of preset 
styles that you can use. A lot of these are a bit garish but, if you delve down a 
bit you can find some really nice ones like Salt from the Complex section.  
 
You’ll find four icons at the top of the Effects panel, Filters, Layer Styles, 
Photo Filters and All. Click on Layer Styles, then click on the drop down list on 
the right and select which sub-section you want to have a look at. The thing to 
remember here is that you click on a style and then click on Apply – nothing 
will happen if you don’t click on Apply.  
 
There are no options to adjust here, just preset versions to choose from. 
However, once you’ve applied you style, you can double click the fx symbol 
and it will give you the styles dialogue box and you can sometimes adjust 
some of the settings that make up the style. 
 
An easy way to see what styles do is to add some text to an image and apply 
various styles to the text layer and see what happens. 
 
The results of applying these styles will vary considerably depending on what 
the layer contains. Sometimes there is virtually no change at all. For instance,  
if the contents of the layer go all the way to the outer edge and you try to 
apply a drop shadow then there is nowhere for the drop shadow to go!  
 
It’s probably stating the obvious but a layer style applies to the whole contents 
of the layer. So if you want to apply a style to an element of a layer you need 
to select and copy that element on to a separate layer and then apply the 
style.  
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Notes: 
➢ You can’t apply a layer style to a locked background layer – you need 

to unlock it first. 
➢ You can only apply a style to a single layer at a time. 
➢ Layer styles are cumulative so you can apply several to each layer if 

you wish. 
 

Adding a Levels Adjustment Layer 
Real photographers will know this function backwards as it is used extensively 
to correct things like over/under exposure or to remove a colour cast. My 
emphasis throughout this course has been to stress the creative aspects of 
Elements so I’m just going to show you one way to use levels that I think fits 
the bill. If you enjoy the more formal aspects of photography as well, do have 
a better look at levels. 
 
The example I used is of some dried manutex (sodium alginate thickener) 
which I allowed to dry on a Perspex sheet and then scanned at a high 
resolution. I then rotated it and cropped a section out which I then zoomed in 
on. I thought it would be a more interesting image if it had much more 
contrast. 
 
I tried a brightness and contrast adjustment layer but even at full adjustment it 
was still a bit dull. 
 
I then tried a levels adjustment layer. I zoomed right in so that I could see the 
detail well. I then selected the white eye dropper and clicked on the area I 
considered to be the brightest of the image. I repeated the process with the 
black eye dropper and the darkest part of the image. Elements redistributed 
the tones between these two points in the best way it could. The result was a 
much zingier image. 
 

Miscellaneous tools 
 
Cookie cutter 
I must admit I used to dismiss the cookie cutter, thinking that it was only good 
for making rather twee shapes, but I’ve realised recently that it can have its 
uses.  
 
The function most people use is to simply cut an image out into a particular 
shape – a sort of fancy crop tool to give you pretty cutout hearts or cute 
animal shapes. Not particularly my cup of tea but they have their place. 
However, if you delve down into the shape options you have on the Options 
Bar then there are some rather more interesting shapes you can use. My 
favourites are in the crop shapes section. These can be really useful for giving 
interesting edges to your images. 
 
Once you’ve created your shape, you can move it to a different part of the 
image or you can adjust the size and rotation by dragging it round with your 
mouse. Once you are happy with it, accept the changes by clicking on the 
green arrow or using the enter key. As with all tools there are further options 
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that you can play with, such as being able to set specific dimensions or being 
able to start your image from the centre instead of the top left. 
 
Dodge & burn tools 
These two tools are under the sponge tool in the toolbox and are used to 
selectively lighten (dodge) or darken (burn) areas of an image. The names 
come from traditional darkroom  techniques which do the same thing. 
 
Smudge tool 
You’ll find this tool under the Blur tool in the toolbox and, appropriately, looks 
like a finger just about to smudge some paint around. This does just what it 
says and definitely brings out my inner child. The Blur tool can also be useful 
if you want to soften edges or just create areas of soft focus. 
 

Merging layers and flattening images 
 
You can find the commands for merging layers and flattening images in the 
Layer menu, and in  the drop down list hidden under the symbol that is made 
up of 4 horizontal lines at the top right of the Layers panel. You can also see 
them by right-clicking on a layer within the Layers panel. 
 
I’m just going to whizz through these as I use them very rarely. I’ll explain why 
shortly. 
 

➢ Merge down – this merges the active layer with the one below. If you 
have more than one layer selected then the same option in the list 
reads Merge Layers. 

 
➢ Merge Visible - this does just that, merges together all the layers that 

are visible, ie not switched off, into one layer. 
 
One variation that I do use quite a bit is Stamp Visible. This combines all the 
visible layers into a new, merged one. This is very handy if you are creating 
something like repeating patterns where you want to copy, perhaps, a row of 
repeated images, each on a separate layer, in order to create a mirrored 
design. You could, of course, simply merge all the layers before you copy and 
paste them but, if you then change your mind and want to go back to tweak 
something on an individual layer then you’d have a lot more work to do.  
 
I haven’t found this command in any of the usual menus but I read about it in 
a book somewhere. As far as I know there is only the keyboard shortcut for it 
which is  Ctrl-Alt-Shift-e. The only problem I have with this command is 
manoeuvring my fingers round to hold all four keys down at the same time – 
digital gymnastics. 
 
The next possibility is to flatten the image entirely into one combined layer. 
Why would you want to do this manually? I don’t think I’ve ever done so and 
my thinking is this: for day to day working/storage I stick to .psd or .tif formats 
as both these retain all the layer information so I can go back and edit them 
individually at a later date if I wish. If I want to reduce the file size for emailing 
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or using on a web site then I would copy the original to a .jpg. This reduces 
the file size considerably and flattens the layers in the process. So I would 
end up with two versions of the image for different purposes.  
 
The original argument for flattening an image once you were finished working 
on it was to save storage space but hard disks and other forms of storage are 
so cheap now that that isn’t really an issue. 
 
However, you might want to send an image for someone else to work on 
whose software doesn’t support layers. In this case a tip from Barbara 
Brundage’s book in the Missing Manuals series is that if you use Flatten 
Image then Elements creates a background layer, made up of the combined 
layers and background layers don’t support transparency so any transparent 
areas are usually converted to white. If you use Merge Visible the layers are 
still combined into one but any areas of transparency are preserved. 


